# Table of Contents

Installation .................................................................................................................................................. 4

  Upgrading versions................................................................................................................................. 5

  Uninstallation......................................................................................................................................... 6

Getting Started ......................................................................................................................................... 7

  Logging In ............................................................................................................................................... 8

    Enter registration details.................................................................................................................. 9

    Verify email address......................................................................................................................... 10

  Activating Offline ...............................................................................................................................11

The Main Window ..................................................................................................................................13

  Log in to PlayIt Live .............................................................................................................................14

  Live-Assist Mode ................................................................................................................................16

    Segue Editor......................................................................................................................................24

    Voice Tracking ...............................................................................................................................29

      Remote Voice Tracking .................................................................................................................33

  Decks Mode (Classic) ..........................................................................................................................36

      Decks Mode player .........................................................................................................................38

  QuickCarts ..........................................................................................................................................40

      QuickCarts Pages Window ...........................................................................................................43

      Edit QuickCart Window ...............................................................................................................45

  Pre-Fade Listen Window ....................................................................................................................49

Settings .....................................................................................................................................................50

  General Tab .........................................................................................................................................51

  Decks Mode .......................................................................................................................................54

  Live-Assist Mode (and Voice Tracking).............................................................................................55

  QuickCarts .......................................................................................................................................58

  Keyboard ............................................................................................................................................60

  Advanced ..........................................................................................................................................63

Administration .........................................................................................................................................64

  Tracks.................................................................................................................................................65

    Manage Tracks Window ..................................................................................................................66

    Edit Track Window ..........................................................................................................................68

    Bulk Editing Tracks .........................................................................................................................71

  Add New Tracks Wizard Window ......................................................................................................73

    Additional Options Section ...........................................................................................................75

    Progress Section ............................................................................................................................77

    Review Section ..............................................................................................................................78

    Group Section ...............................................................................................................................79

  Track Groups ......................................................................................................................................81

    Manage Track Groups Window .......................................................................................................82

    Choose Track Group Type Window .................................................................................................84

    Edit Listed Track Group Window ..................................................................................................85

    Edit Filtered Track Group Window .................................................................................................88

    Edit Grouped Track Group Window ...............................................................................................90

  Monitored Folders ............................................................................................................................92

    Manage Monitored Folders Window ...............................................................................................93

    Edit Monitored Folder Window ......................................................................................................94

  Logged Tracks ....................................................................................................................................96

    Logged Tracks Window ...................................................................................................................97

  Playout Policies ..................................................................................................................................99

    Manage Playout Policies Window ..................................................................................................100

    Edit Playout Policy Policy Window ...............................................................................................102
Installation

To install PlayIt Live, download the latest version from http://www.playitsoftware.com/Products/Live.

Once the download is complete, run the downloaded .exe file.

You will first be presented with the software licence agreement. Once you have read and agree to these terms, click I Agree.

Choose the components to install. Here you can select whether to install Start Menu shortcuts. No shortcuts will be created on the desktop. Click Next to continue.

Next, choose the location to install the software. By default, this is in Program Files, but can be changed to your preference. Click Install to begin the installation.

Tick Open Program Folder to launch the Start Menu folder when you click Finish.

Double click the PlayIt Live icon to launch the application.
Upgrading versions

New versions of PlayIt Live are regularly available from http://www.playitsoftware.com. It is important to back up your data before you install any new versions. Data and logs for PlayIt Live are stored in the Windows 'ProgramData' folder.

By default, on Windows Vista, 7, 8 and 10 this is located at:

   C:\ProgramData\PlayIt Live

By default, on Windows XP, this is located at:

   C:\Documents and Settings\All Users\Application Data\PlayIt Live

To back up your data, simply copy this folder to an alternative location, such as an external hard drive.

When a new version is installed, or an old version is uninstalled, the data in the location above will not be removed.
**Uninstallation**

When installed, PlayIt Live will include an **Uninstall** shortcut in the Start Menu.

If you chose not to add Start Menu shortcuts the Uninstaller can be found at (by default):

- `C:\Program Files (x86)\PlayIt Live\uninstall.exe`
- `C:\Program Files\PlayIt Live\uninstall.exe`

Double-click the icon to start the uninstall process. Click **Uninstall** to remove PlayIt Live.

Note that your PlayIt Live data will not be removed when you uninstall. To remove your data, see [Upgrading versions](#) for details of the data location.
In order to begin using PlayIt Live, you need to log into your PlayIt Software account. Click the **Log In** button to begin logging in. If you do not have an account, one can be created by clicking **Register** or visiting [https://www.playitsoftware.com/Account/Register](https://www.playitsoftware.com/Account/Register).

If the computer you are using is not connected to the internet, you can [activate offline](#).
Logging In

To begin using PlayIt Live, enter your PlayIt Software account email address and password, or you can log in using your Facebook account.

From the **Get Started** window, click **Log In**...

Once you are logged in, the **main window** will be shown.
If you do not already have a PlayIt Software account you can register your details here. Enter the required details and click **Register**.
Once you have registered you will need to check your registered email account and follow the link in an email with the subject "PlayIt Software: Please verify your email address...". To ensure you receive this email, please add noreply@playitsoftware.com to your address book. Once you have followed the link you will be logged in and the main window will be shown.
**Activating Offline**

If the computer on which you have installed PlayIt Live is not connected to the internet is it possible to activate offline.

From the **Activation** window, click **Activate Offline...**

![Activate Offline window](image)

To activate this computer offline, you need to visit:

https://www.playitsoftware.com/Account/Licences

from another computer. Choose the Generate a New Licence option and enter the details below:

- **Computer Name:** PLAYIT-BOX
- **Machine Code:** 0E4C0-29509-2CD3C-BB1C7
- **Licence Key:** (space for licence key)

From the **Activate Offline** window, you can enter your Licence Key. This is generated from the Licences page in the **My Account** area of the PlayIt Software website. A licence can be generated by visiting: http://www.playitsoftware.com/Account/Licences/Generate. You may be prompted to log in or create an account.

From the **Generate New Licence** section, select PlayIt Live and ensure that v2.00+ is selected as the version. Enter the Computer Name and Machine Code you see on PlayIt Live and click **Generate Licence Key.**
Generating a licence manually should only be required if you need to activate a computer that does not have access to the Internet or you are having trouble activating the product using the Activate Online... button.

Select the product you want to generate a licence for:

PlayIt Live

Version:

[2.00+ (latest)]

Enter your computer name:

PLAYIT-BOX

Enter your machine code:

[0E4C0-29509-2CD3C-BB1C7]

Your machine code can be found by clicking the Activate Offline... button when you first run the product.

Generate Licence Key

Once generated you will be presented with a licence. Make a note of the Licence Key and copy this to the PlayIt Live window. Alternatively, download the licence file and select the file within PlayIt Live.
The Main Window

When PlayIt Live first starts it will be presented in Live-Assist players mode. The player mode can be changed from File > Settings > Player Mode.
Log in to PlayIt Live

[Image of login window]

Note:
If you have just installed PlayIt Live you will not see this section. To require users to log into the system go to Manage > Users and click Require users to log in to use PlayIt Live.

If you are required to log into PlayIt Live you will be presented with the log in window. Enter your username and password and click Log In.

You may be required by your administrator to change your password if your account was nearly set up:

[Image of password change window]

Enter your password and confirm your password and click Change Password.

Forgotten Admin Password:
If you are an administrator and have forgotten your password, you can reset your password by logging into your PlayIt Software account on the PlayIt Software website with the same account as that who has licenced the software. Visit https://www.playitsoftware.com/Account/Dashboard/ResetAdminPassword and verify that the
Client ID matches. Enter the Reset Code Part 1 into the website which will generate Reset Code Part 2. Enter Part 2 into the box in PlayIt Live and click **Reset**. You will be prompted to change your password.

If you have forgotten your admin password you can reset it by logging into your PlayIt Software account and resetting it via this page and filling in the fields to generate Part 2 of the Reset Code:

[https://www.playitsoftware.com/Account/Dashboard/ResetAdminPassword](https://www.playitsoftware.com/Account/Dashboard/ResetAdminPassword)
Live-Assist Mode

1. Menu
2. Notification bar
3. Player
4. Internet broadcast indicator (plug-in)
5. Track Group selector
6. Track search box
7. Currently logged in user
8. Track list
9. Special items
10. Onscreen Clock
11. Log Scheduler Switch
12. Automation Switch
13. Master controls
14. QuickCarts panel
15. QuickCarts drag/drop panel
16. QuickCarts drag/drop panel (open)
The top menu bar provides options to set up PlayIt Live.

The **File** menu contains:

- **Enable remote connections**: Set up PlayIt Live to enable the built-in remote management server at allow remote connections for managing data.
- **Sync with a remote server**: Set up PlayIt Live to connect to a remote management server such as PlayIt Manager or the built-in server in another PlayIt Live. See [Synchronising Data](#).
- **Settings**: Configure the user interface and audio devices.
- **Exit**: Close PlayIt Live. A confirmation box will be shown.

The **Manage** menu contains:

- **Tracks**: Manage track audio items. See [Manage Tracks](#).
- **Track Groups**: Manage track groups (like smart folders) containing tracks. See [Manage Track Groups](#).
- **Logged Tracks**: View recently played tracks for reporting purposes. See [Logged Tracks](#).
- **Playout Policies**: Manage rules to create a unified sound. See [Manage Playout Policies](#).
- **Playout Pattern**: Manage the pattern of track groups that will be used for playout. See [Manage Playout Pattern](#).
- **Clocks**: Manage hour templates used to generate the playout log. See [Manage Clocks](#).
- **Clock Schedule**: Manage clock hourly assignments used to generate the playout log. See [Manage Clock Schedule](#).
- **Playout Log**: Manage the overall, day-to-day output of your station. See [Manage Playout Log](#).
- **Scheduled Events**: Manage events that can be triggered to happen at a specific time or when PlayIt Live starts. See [Manage Scheduled Events](#).
- **Users**: Manage users who can log in to use the software. See [Manage Users](#).

The **Tools** menu contains:

- **Missing Track File Analysis**: Find and resolve tracks that reference files that have been moved or deleted. See [Missing Track File Analysis](#).
- **Duplicate Track File Analysis**: Find and delete track files that have been added to PlayIt Live multiple times. See [Duplicate Track File Analysis](#).
- **Monitored Folder Status**: View the status of your monitored folders and force a re-scan if necessary. See [Monitored Folders Status](#).

The **Plugins** menu contains:

- **Plugin Manager**: View the list of currently installed plugins and create new ones.

[Number of running plugins]

The **Help** menu contains:

- **Online Documentation**: A link to the documentation page on the PlayIt Software website.
- **Donate**: An opportunity to give back to PlayIt Software.
- **Licence Information**: View your currently applied licence information and allow you to update your licence.
- **About PlayIt Live**: View that latest version and check for updates.

**Notification bar**

The notification bar is used to provide important information to the user without disrupting their current activity. Warnings will be displayed here if there are any setup issues or a track fails to load.
Players

The players at the top load tracks from the playout log in the expected order. Players can be assigned to individual sound cards so they can be used with different channels on a professional mixer.

Each player has three timers and three buttons.

The **blue** timer indicates the intro remaining of the loaded track.
The **green** timer indicates the elapsed time of the loaded track.
The **red** timer indicates the remaining time of the loaded track.

The **green** play button starts playing the track.
The **orange** pause button pauses the track. Pressing this button again resumes playout.
The **silver** eject button fades out and stops the player.
The playout log shows the upcoming items that are scheduled to take place. Typically these are tracks to be played, break notes or fixed time markers. Each playout log item features (from left to right) the play time, icon, title, duration, segue toggle switch, edit and eject/remove button.

**Icons**

The icon on the log item displays the type of the item:

- 🎵 - Track
- 🎤 - Voice Track
- 📝 - Break Note
- 🕒 - Fixed Time Marker
- 🔴 - Currently playing item
- 🗓 - Past item that was played
- 🗓 - Past item that was not played
- 📣 - Future item that will not be played due to fixed time marker

Icons and colours can also be customised based on the track group a track belongs in.

**Current Item**

The current item is indicated by the right arrow in a circle icon:

- 🔷

The current item is the currently playing or next item to be played.

**Adding tracks**
To add a track to the playout log, drag and drop a track from the Track List to a position between existing tracks or between an empty 'drag tracks here' marker. If you dragged a track into a position soon to be played it will be loaded into one of the players in sequence.

**Playing tracks**
To play the track, click the Play button in the player at the top. When an item is playing it will be shown in green and display the remaining time for that item.

While a track is playing the progress bar will be displayed showing the current position in the track. To change the position, click the Seek checkbox to the left of the progress bar and then click the position in the progress bar to change the position. The Seek checkbox is there to prevent the position of the track from being accidentally changed whilst on air.

![Progress Bar with Seek Checkbox]

**Navigating the playout log**
It is possible to scroll up to past items to see what was played, or scroll down to see what is going to be played next. Do this by scrolling with the mouse wheel or using the up and down arrows to the right of the playout log.

![Scrolling Arrows]

You can click the **Home** button to return to the current item. The Home button has two states, underlined and not-underlined. When the Home button is underlined the playout log will automatically scroll with the current item. If you manually scroll away from the current item, the Home button will no longer be underlined and the playout log will stop automatically scrolling.

![Home Button]

The **Go To Time** button can be used to navigate to a specific date and time in the log. This is useful if you wish to edit the log or record voice tracks for a future programme. This button will launch a window where you can choose the date and time.

**Toggling segues**
A segue is the transitioning of one item into another item. The segue toggle switch is used to say whether an item transitions into the next.

The segue toggle switch changes between a green arrow and a red stop sign.

![Segue Switch]

A green arrow indicates that the succeeding track will automatically play after this track. A red stop sign indicates that playout will stop after this track has finished. To resume playback, click the play button on the player or the master controls.

**Fine tuning segues**

The **Edit** button allows you to fine tune the segue between the current, preceding and succeeding tracks. This will launch the segue editor.

**Recording voice tracks**

![Recording Button]
For voice track items the edit button will be replaced by the Record button. This will launch the segue editor allowing you to record your voice track. Until a voice track is recorded, a voice track item will display a placeholder entry. This will not be loaded into a player and will be skipped if a voice track has not been recorded. You can change the length of the placeholder duration by clicking on the duration, by default this looks like [00:30].

Remove

Click the Remove button to remove the playout item from the log. If the item is currently playing, it will fade out and the next item will play if segue option is.

The log contains headings for the hour for which the item is scheduled. Use this as a guide to schedule tracks in the future.

Displaying more information about a track

You can display more information about a particular track by clicking on the log item. The Out Cue, Intro, Album, Genre and Year are displayed on the left with the Comment field displayed on the right. If any field is too long to be displayed in the box you can hover over the text to display the full text.

Note: If the track was recently played the Last Played time is also displayed.

Navigating the playout log with the keyboard

You can quickly navigate the playout log by selecting an item and then using the keyboard keys. The following keys can be used:

Up: Move the selection one item up.
Down: Move the selection one item down.
Page Up: Move the selection one page up.
Page Down: Move the selection one page down.
Home: Move the selection to the current item.

QuickCarts panel

See QuickCarts.
Internet broadcast indicator (plugin)

The status of your internet broadcast. This plugin can be installed from the Plugin Gallery window.

Currently logged in user

This shows the user who is currently logged in. To log out, click the button and then click Log Out.

Track Group selector

To filter the track list by track group, select the track group from the dropdown. The track list will show only tracks that exist in the selected track group. Track groups can be managed from Manage > Track Groups.

Track search box

Use the search box to filter the track list. When text is entered into the search box the track list will show only track titles (Artist - Title) that contain the entered text. To clear the search click the . It is not possible to filter by duration.

Track list

The track list shows a list of tracks added to the system. Tracks in this list can be managed from Manage > Tracks. The list shows each track in the form Artist - Title with the duration in the second column. Click either column to sort by that column, click the column again to reverse the sort order. The list can be filtered using the search box or the Track Group selector above.
Special items

While Tracks are a fundamental playout log item type, you can also insert special items into the log. Simply drag and drop the box for the item type you want to insert into the playout log.

Onscreen Clock

The onscreen clock shows the current date and time.

Log Scheduler Switch

Switch the log scheduler ON to automatically schedule the playout log so that there are always items scheduled to play out. This is the equivalent to Semi-Auto mode in PlayIt Live v1.

Automation Switch

Switch automation ON to automatically schedule the playout log and locking it so it cannot be changed. This is the equivalent to Auto mode in PlayIt Live v1. Switching Automation ON will also switch on the Log Scheduler.

Master controls

The master controls control the overall player status. Click the Play button to start the next item in the playout log. Click the Pause button to pause all playing players. Click the Stop button to fade out and stop all playing players. As you would expect, any playing playout items will automatically be set to not advance to the next track.
Segue Editor

The segue editor is used to give you greater control over how tracks are sequenced. Tracks can be moved closer or further away from the preceding or succeeding track. If you are familiar with PlayIt VoiceTrack, the segue editor operates in the same way. It is possible to move tracks, trim the start and end, and fade tracks in and out or adjust the volume.

Waveform

The waveform represents the audio signal. It shows the changes in amplitude over the duration of the track.

Fade envelope

Changing the fade envelope allows you to adjust the volume of the track. Click the orange line on the waveform to edit the fade envelope. Clicking on the line will create an envelope point. Adding multiple envelope points will allow you to create a shape to adjust the fade volume. To remove a point drag the point outside the waveform box. The light-grey envelope shown is the effective envelope when a track playing at the same time has Duck other tracks enabled.

Waveform top bar

Drag and drop the top bar of the track to align it with the previous or next track.
A thick vertical line shown on the track represents a cue point marker. The Cue In point is shown in **green**, the Cue Out point is shown in **pink** and the Intro point is shown in **cyan**. Cue Points can be changed via Manage > Tracks and editing a track.
Recording and playback controls

Record button: start recording from your microphone. Please see Voice Tracking section more details. This button is disabled if you are not editing the segue for a voice track.

Delete recording button: deletes the recording so it can be discarded. This button is disabled if you are not editing the segue for a voice track.

Play button: start playback from the current playback position. Tip: You can use the space bar to perform this action.

Pause button: pause playback at the current playback position.

Stop button: stop playback and reset to the previously selected position marker. Tip: You can use the space bar to perform this action if audio is playing.

Jump to start: move the position marker to the start of the view. Tip: You can use the home key to perform this action.

Move to previous track: move the position marker to the previous track from the current position. Tip: You can use the page down key to perform this action.

Move to next track: move the position marker to the next track from the current position. Tip: You can use the page up key to perform this action.

Jump to end: move the position marker to the end of the view. Tip: You can use the end key to perform this action.

Current playback position: indicates how long has elapsed in the project

00:04:03.8
Zoom controls

As an alternative to using the mouse wheel to zoom the multi track view, you can use the zoom buttons to zoom in and out.

Previous/Next Segue buttons

Quickly move to the previous or next tracks in the playout log. These can be used to iterate through the tracks in the playout log efficiently.

Previous/Next Voice buttons

As above, but you will advance to only voice track segues. These can be used to iterate through voice tracks and quickly record voice tracks. These buttons are disabled if there are no voice tracks nearby in the log.

Segue Information

The segue information shows how the selected track will sequence from the previous track into the next track. To see the segue information for the track simply click on the waveform.

The segue style defines specific ways that the track will sequence:

By default, the segue style is **Cue Out/In**, this means the cue in of the track will line up with the cue out of the previous track.

For **Sweep Start**, the sweeping track will start at the same time as the next track, provided it is short enough to play before the intro point of the next track. If the sweeping track is longer than the intro of the next track, the sweeping track will start before the next track and play up to the end of the intro.

For **Sweep Intro**, the sweeping track will finishing playing immediately before the end of the intro point of the next track.

For **Custom**, you can manually set up how the tracks sequence with each other.

When you move a track by dragging the waveform the segue style will automatically change to Custom.

Note that **Sweep Start** and **Sweep Intro** require Intro points to be set on tracks, otherwise **Cue Out/In** will be used.

The **Duck other tracks** checkbox can be used to reduce the volume of the previous and next track when this track is played. You can configure the ducking (volume and speed) via the Settings button. When ducking is active you can see the effective track envelope changing to show the volume change.
**Settings button**

The settings button allows quick access to voice tracking settings from the segue editor. Here you can edit the audition time or the audio devices for playback or recording.

**Save button**

Save your segue changes and close the segue editor window.

**Cancel button**

Discard your segue changes and close the segue editor window.
Voice Tracking

PLEASE NOTE:

Voice tracking is a premium feature of PlayIt Live and requires a valid Voice Tracking module applied to the PlayIt Live licence to enable full functionality. Without a valid Voice Tracking module applied all voice tracks will be preceded by an audio notice requesting that you purchase the module. To use voice tracking in PlayIt Live, purchase the Voice Tracking module licence and refresh your PlayIt Live licence.

Voice tracking is an industry-standard technique to create the illusion that there is a live announcer sitting behind the desk in a radio studio whereby in fact all the audio has been prerecorded and played out automatically. Voice tracking can allow you to record a three-hour show in less than half an hour.

PlayIt Live enables you to do this by inserting Voice Track items into the playout log and recording the audio with your microphone. The recorded audio can then be sequenced with other tracks in the log and tweaked using the segue editor. It is also possible to record voice tracks remotely, on another computer, and send these voice tracks to PlayIt Live. For more information on this see .

Start by dragging tracks into the log for the hour you wish to voice track:

```
Hour: 31 July 2016 16:00

16:03:56  Alt-J - Breezeblocks  03:19
16:07:16  Real Estate - It's Real  02:41
16:09:58  Jingle - Download Podcasts ID B  00:09
16:10:07  Madeon - Finale  02:46
16:12:54  Swim Deep - Honey  03:27
16:16:21  Emeli Sande - Heaven  03:59
16:20:20  The Subways - Kiss Kiss Bang Bang  02:51
```

Then drag a Voice Track item into the log for every voice track you would like to record between tracks:
A placeholder will be shown in the playout log for each voice track item you need to record. Click the red circle record icon on the voice track you wish to record.

The segue editor will be shown allowing you to record your voice:

If you are using voice tracking for the first time, go to Settings... and ensure that your microphone device and audition time settings are set up correctly. The audition time is the number of seconds of the end of the previous track you will hear when you start recording your voice track. Remember to click OK to save your settings.

To start recording your voice track click the Record button, or press the R key.

A pop-up box will be shown if you have not purchased a VoiceTrack licence: see note.
Your recording will start and you will hear the end of the previous track. Start speaking to record your voice. The record button will change to the Play Next button:

Click the Play Next button to play the next track after the voice track, or press the R key again. The button will change to the stop button:

Click the Stop button to finish recording, or press the R key one more time.

Your segue editor view should now look something like this:

You can trim the audio of the recording by clicking the edges of the waveform to remove any unwanted audio at the start or end of the recording. You can also move the audio around by clicking and dragging the top bar the waveform and edit the volume by clicking and dragging on the orange fade envelope.
You have now recorded your first voice track. Click **Next Voice** to save and record the next voice track, or click **Save** to save and return to the playout log.

The voice track will now be shown loaded into the players if playing next, and shown in the log with the other tracks.

Voice tracks can be recorded as far in advance as you need. Just scroll down the playout log to the required time.
Remote Voice Tracking

PlayIt Live can be configured to allow users to connect from another computer at home or another studio and record voice tracks in your playout log. They can also edit the segues and add additional tracks if they wish.

You will need to do the following to allow remote users to connect:

1. Enable remote connections by starting the built-in remote server.
2. Set up users, including username, password, and the hours they are allowed to editing in the playout log.
3. Add voice track placeholders to the playout log where users can record voice tracks.
4. Give the remote URL from step 1 and a username and password from step 2 to the user.

---

1. Enable remote connections

From the main interface, go to **File > Enable remote connections**...

![Enable remote connections](Image)

The default server port of 25433 should be fine, click **Start Server**

![Start Server](Image)

This will enable remote connections to PlayIt Live. Depending on your configuration, you may be required to configure your Windows Firewall and network port forwarding to allow connections from outside your network. You can use the **Help me set up external access** button to assist you with this.

![Help me set up external access](Image)

You can also take a look at this video for more guidance: [https://youtu.be/kIyp9CivSAQ?t=1m22s](https://youtu.be/kIyp9CivSAQ?t=1m22s)

Under external access is a **remote URL** that will be used by the remote user to connect. Take note of this:

![Remote URL](Image)

You can access PlayIt Live remotely via **http://10.99.129.25433**.

Please note this address may change if you do not have a static IP address with your internet service provider. You may wish to consider a dynamic DNS provider to ensure you can use the same address to access PlayIt Live externally.

2. Set up users

From the main interface, go to **Manage > Users**
On the Manage Users window, click **Add New**. Enter a display name, username and password for the user. Then click **Add** under **Remote Voice Tracking** to select an hour in the week where the user is allowed to remotely voice track:

Keep adding more hours that the user should have access to:

Add more users as necessary.

Click **OK** on the Manage Users window to apply the changes.

3. **Add voice track placeholders**

Voice track placeholders are gaps in the playout log where users can record their voice tracks. You can add voice track placeholders to the playout log by dragging the Voice Track button onto the playout log:
You can use the Go To Time button to go straight to an hour to drop voice tracks for a future hour.

Alternatively you can add voice track placeholders directly via Manage > Playout Log or via a clock via Manage > Clocks.

4. Connect a user
Once you have set up the above, contact your remote trackers sending them the remote URL and their username and password. Remote voice trackers are required to use PlayIt VoiceTrack to connect. Please refer to the [PlayIt VoiceTrack documentation](#) for details of setup of remote voice tracking from a remote voice tracker’s perspective.

**A note on licensing:**
A Voice Tracking module purchase is required to broadcast voice tracks via PlayIt Live. Remote voice trackers do not require the Voice Tracking module to send their voice tracks to PlayIt Live. Only a limited number of users can be connected concurrently. This is determined by the number of users that were selected when purchasing the Voice Tracking module.
Classic Decks Mode emulates a cart machine where a disc jockey would have to physically press a button to control the cart.

**Player**

![Player interface](image)

00:00  Babylon Zoo - Spaceman
00:05
03:41

See Decks Mode player.

**QuickCarts panel**

![QuickCarts panel](image)

See QuickCarts.

**Onscreen clock**

![Onscreen clock](image)

See Onscreen clock.
Track List

See Track list.

Track search box

See Track search box.

Track Group selector

See Track Group selector.
A Decks Mode player is loaded with a track by dragging and dropping a track from the Track List or from a file on your file system. When a track is loaded, it is automatically cued to the Cue In point if this is set on the track.

1. **Intro**
   - 00:00
   - The blue timer indicates the intro time remaining on the playing track.

2. **Elapsed**
   - 02:59
   - The green timer indicates the elapsed time on the playing track.

3. **Remaining**
   - 47.78
   - The red timer indicates the remaining time on the playing track.

4. **Out cue**
   - **Out: Fades**
   - The Out text is displayed when the Out Cue information is entered on the track.

5. **Track title**
   - **Babylon Zoo - Spaceman**
   - The track title is shown in the form Artist - Title.

6. **Play**
   - The Play button starts playing the track.
Pause

The **Pause** button temporarily suspends playback of the track. Click this again to resume playback.

Stop

The **Stop** button fades out and stops the track.

The stop button is replaced with the **Eject** button when the track is not playing or no track is loaded into the player.

Toggle scrubber

Used to toggle scrubbing (seeking) on the progress bar. The progress bar will turn blue when this is active.

Progress bar

The progress bar indicates the duration that has elapsed for the track in the player. The elapsed time is shown in black by default but shown in blue when scrubbing (seeking) is active. Scrubbing is activated by clicking the Toggle Scrubber checkbox to the left.

The progress bar features a number of highlightings:
- **Gray**: Cue in point
- **Silver**: Intro point
- **Pink**: Cue out point
QuickCarts are single click one-shot players. They are typically used to play jingles, promos or beds. Simply drag-and-drop a track from the track list or an audio file from Windows Explorer onto the QuickCart to load it into the player.

QuickCarts can be configured as a panel of rows at the bottom of the main window, or as a separate window (like a cart wall) which can be placed on a separate monitor. You can also configure multiple pages.

QuickCarts can be shown on multiple pages. This is convenient if specific jingles are used on certain shows so a page can be created for later use.

Use the left and right arrows to navigate pages and click the page name to launch the QuickCart Pages window.
QuickCarts can be displayed in multiple rows. When loaded, the player appears in the default colour displaying the artist and the title of the track with the remaining time below.

In Playback operation mode, to start the player, simply click anywhere in the box. When playing, the progress is shown as the background and the status 'PLAYING' will be shown. If the cart is configured to Loop, when the position reaches the Loop B point (or the end if Loop B is not set) it will return to the Loop A point and continue playing. The status 'LOOPING' will be shown. If the cart is configured as Solo, then this cart is played, all other playing carts will fade out and stop. It will also fade out and stop if any other carts start playing. Solo carts are designed to be the only cart playing at any particular time.

In Playback operation mode, to fade out and stop the player when it is playing, simply click the box again. The player will turn a dark shade of grey and the status 'FADING' will be shown. To force a stop and bypass fading click the box once again. The fade time is configured in Settings. By default the playback sequence is Play -> Fade out -> Stop, this can be changed by editing a cart. Possible options are to immediately stop and not fade (Play -> Stop) or cease looping if the cart is looping (Play -> Cease loop -> Fade -> Stop). When the loop has ceased, the status 'FINISHING' will be shown and the cart will play until the end or until the cart is clicked again when it will fade and stop.

Indicates the position of the current page in relation to the other pages. Click a circle to navigate to that page.
4 Playback operation mode

Click the hand button to enter the Playback operation mode. This will allow you to play, fade out and stop the players.

5 Edit operation mode

Click the pencil button to enter the Edit operation mode. In this mode when you click a QuickCart the Edit QuickCart window will appear. This will allow you to select a new track or file and operationally override the artist and title. In this mode, right click to eject the player.

6 Paint operation mode

Click the paint bucket button to enter the Paint operation mode. In this mode when you click a QuickCart the background colour of the QuickCart will change. To change the colour that is painted, double-click the paint button. This will allow you to select a new colour.

TIP: While in Edit or Paint mode, hold the CTRL key to temporary enter Playback mode.
The QuickCart pages window is used to make changes to the pages found in the QuickCarts dock or window. All actions performed in the window will be applied immediately to the QuickCart component.

1. **Page list**
   - The page list box shows the list of pages in order. Select a page here to rename it, delete it, or change its position in the list. Double-click on an item in the page list to make it 'current' and quickly navigate to that page on the main window.

2. **Add Page button**
   - Click the Add Page button to add a new page to the bottom of the list.

3. **Rename Page button**
   - Click the Rename Page button to rename the selected page.
Delete Page button

Click the Delete Page button to delete the selected page. A confirmation window will appear to ensure you want to delete the page as this is an irreversible action. It is not possible to delete the last remaining page.

Move Up button

Click the Move Up button to move the selected page one position up in the list.

Move Down button

Click the Move Down button to move the selected page one position down in the list.

Close button

Click the Close button to close the window.
Choose between Track and File as the source of the audio file. Choose Track to select a track already added into PlayIt Live. Choose File to select a file from the file system if you do not wish to add it to PlayIt Live.

Click the track title link to select a new track. This section is only available if you have selected the Track type selection above.

This section shows the file path of the audio file. If you have selected the File type above, click the Browse button to select a new audio file.
4 **Artist**

Click the Artist checkbox and type into the text box to override the artist that will be displayed on the QuickCart.

5 **Title**

Click the Title checkbox and type into the text box to override the title that will be displayed on the QuickCart.

6 **Background colour**

Click the colour box to select a new background colour for the QuickCart. Click **Use Default** to revert to the default colour (blue).

7 **Solo**

If Solo is checked, when the cart is played it will cause all other carts to fade out and stop. This cart will also fade out and stop when any other cart starts playing. Solo ensures this cart is the only cart playing at any particular time.

8 **Loop**

If Loop is checked, when the cart is played it will loop between points Loop A and Loop B. The Loop A and Loop B cue points will appear in the Cue Points section when Loop is checked. If Loop B is not set, the cart will loop from the end of the cart. If Loop A is not set, the cart will seek to the Cue In point when the loop point is reached.
The playback sequence determines how the cart behaves when the cart is clicked on the main interface. In this example, the cart will Play, then Fade out, then Stop respectively for each mouse click. To change how the cart behaves, click any blue link. For example 'Fade out' above will display the following options allowing you to change this to Stop immediately:

and change the playback sequence to:

For looping carts there are additional options:

You can choose to 'Cease loop' when the cart is clicked. This will prevent the cart from looping anymore and behave like a non-looping cart. You can also choose to 'Go to Loop B' which will cause the cart to jump to the end of the loop sequence. This can be useful if you have a background bed that loops, but also has an end that you want the listener to hear when you have finished speaking.

Use the Play and Stop buttons to listen to the track. The audio device (sound card) used to play back the audio can be configured in Settings.

The Cue In point is the position in seconds where the track should be started by a player. Use the Set button while listening to the track to set the point to the current position. Use the Test button to listen to the track from the set position.

For looping carts, there are two additional cue points, Loop A and Loop B (see above).
Waveform

The waveform shows the volume of the audio track over time. Overlayed on the waveform in grey is the **Cue In** points that is set above. While playing, click and drag over the track to seek to a different position in the track.

**Analyse button**

Click the **Analyse** button to automatically detect the Cue In point based on the silence at the start of the QuickCart track.

**OK button**

Click the **OK** button to confirm your changes.

**Cancel button**

Click the **Cancel** button to discard your changes.
The Pre-Fade Listen window is designed to allow you to listen to a track on a separate audio device (sound card) without playing it out on air. To launch the Pre-Fade Listen window, double-click any track in the Track List or, if in Live-Assist Mode, double-click on a track title on the playout log.

Player

Operates the same as the Decks Mode player.

Output audio device

Indicates the name of the audio device (sound card) that the audio will playout from.

Close button

Closes the Pre-Fade Listen window.
Settings

The user interface and audio devices can be configured from the settings window. The settings window can be opened by going to **File > Settings** from the Main Window menu.
**Settings section tabs**

Settings are split across six tabs.

**Theme**

Change the appearance of the main interface of PlayIt Live. Choose between Dark (default) and Light themes.

**Track listbox font size**

Use the dropdown to select the font size of the Track List on the Main Window.
On-screen Clock Format

Use the dropdown to select the format for the onscreen clock or to disable it completely.

Fade time

Use the dropdown to select the time it will take to fade out a track when the stop button is clicked on any of the players in PlayIt Live. This also applies when tracks are segued in Live-Assist mode.

Track editor audio device

This is the audio device (sound card) used for playback in the track editor (when adding or editing tracks). The track editor audio device is also used for the player in the Pre-Fade Listen window and the segue editor.

Silence analysis

It is possible to analyse silence in tracks to determine the Cue In or Cue Out points. When the Analyse button is clicked on the Track Editor these settings are used to automatically set the Cue In and Out points. When a file is dragged and dropped from the file system onto a player these settings are also used. This helps achieve the best sounding gapless playback.

Decks player mode selection

PlayIt Live offers two player modes. For information on using Decks Mode (Classic) see: Decks Mode (Classic)

Live-Assist mode selection

PlayIt Live offers two player modes. For information on using Live-Assist Mode see: Live-Assist Mode

User login

Tick this box to require users to log in to use PlayIt Live. Please ensure before you tick this box that you know correct usernames and passwords and how to log into the system. This is the same checkbox you can see under Manage > Users.

OK button

Click the OK button to save any changes you have made. If there are any errors that need correcting a popup box will be displayed.
Click the **Cancel** button to discard any changes you have made and return to the Main Window.
Decks Mode

1 Number of full row decks selection

Number of full row decks: 6

Use the up / down arrows to select the number of full row decks to be displayed. Where there is no limit to the number of decks you can select, you are limited by your screen resolution.

2 Deck audio device assignment

Deck Audio Device Assignments

Each deck can be assigned to a different audio device (typically a sound card) on your computer. Use the dropdown to select the audio device. This can be used to assign each deck to an individual fader or channel on a professional mixer.
**Live-Assist Mode (and Voice Tracking)**

1. **Number of players selection**
   
   Choose the number of players you wish to display at the top of the main window in Live-Assist mode.

2. **Player audio device assignment**
   
   Each player can be assigned to a different audio device (typically a sound card) on your computer. Use the dropdown to select the audio device. This can be used to assign each player to an individual fader or channel on a professional mixer.
Segue Settings

The **default segue** option is the segue type that is chosen when a new track is added to the log via manual drag-and-drop or via the playout pattern.

The **sweeper segue style** is the segue style that is chosen when a track marked as a sweeper is added to the log unless an alternative segue style is chosen via a clock. The segue style can be changed by editing the segue via the Segue Editor.

You can also set whether to duck other players when a sweeper is scheduled. Again, you can change whether a track is ducked via the Segue Editor.

Voice Tracking Licence Status

Voice tracking is a premium feature. A valid licence with the paid-for Voice Tracking module must be applied to enable full voice tracking functionality. [Purchase](#)

**Voice Tracking module expired: voice tracks will be preceded by an audio notice.**

This shows the current status of the Voice Tracking module in your PlayIt Live licence. Voice tracking is a premium feature of PlayIt Live and requires a valid licence with the paid-for Voice Tracking module to enable full functionality. Without a valid Voice Tracking module all voice tracks will be preceded by an audio notice requesting that you purchase the module. To use voice tracking in PlayIt Live, [purchase](#) the Voice Tracking module and refresh your PlayIt Live licence.

When a valid Voice Tracking module is found the following text is shown and voice tracks will no longer be preceded by an audio notice.

**Voice Tracking module found: ready to use**

Microphone Recording Device

The recording device used when recording a voice track from the segue editor window. The device chosen here should not record audio that is played back to avoid music from being recorded into the voice track recording.

Audition Time

When you start recording, this is the number of seconds from the end of the previous track you will hear.

Recordings Folder

The location where the voice track recordings are stored on disk. Click the [Browse](#) button to find the folder on your system. Remember to ensure there is sufficient disk space to store recordings at this location.

Recordings Format

The audio format of voice track recordings. High bit rates are of high quality but take up more space on disk.
Voice Tracking Ducking Settings

- By default, duck other players by [65%] when a voice track is played. Speed: [Fast (250ms)]

You can also set whether to duck other players when a voice track is played. You can change whether a voice track is ducked via the Segue Editor.
QuickCarts

**Toggle QuickCarts**

- **Docked to Bottom**
  
  For Docked to Bottom: this shows or hides QuickCarts below the players on the main window. For Separate Window (Cart Wall): this shows or hides the QuickCarts window which can be displayed on a separate monitor.

**Number of QuickCart rows selection**

Changes the number of QuickCart rows that are displayed.

**Number of QuickCarts per row selection**

Changes the number of QuickCarts that are displayed per row. As more QuickCarts are displayed per row they will be resized to fit the available space on the screen.

**QuickCart audio device**

Each QuickCart section can be assigned to a particular audio device (typically a sound card) on your computer.
Separate window (Cart Wall) section

Settings can be configured for QuickCarts on a separate window. The settings in this section mirror the Docked to Bottom section above.

Enable right click eject in Playback mode

Prior to PlayIt Live version 1.08, it was possible to eject QuickCart players while in Playback mode. Feedback from users has indicated that it was too easy to accidentally eject players.

When this setting is selected, QuickCart players will eject when in Playback or Edit mode. When this setting is not selected, QuickCart players will eject only when in Edit mode.
The keyboard settings section allows you to bind PlayIt Live actions (commands) to keyboard shortcuts. Select an item in the list to edit the binding.
This list shows the possible commands to which you can bind a keyboard shortcut. Select a command in the list to edit the keyboard binding.

## Edit keyboard binding section

Once you have selected a binding from the list, it is possible to edit the binding from this selection. When no key is currently bound the text '<key>' will be shown beside the check boxes.

In the screenshot shown the keyboard shortcut, **CTRL+Right** is bound to move to the next QuickCart page.

To set up this binding from scratch, select CTRL and click the '<key>' text box. You will be prompted to press a key, press the Right arrow on your keyboard. This keyboard shortcut is now configured. To clear the binding, click the **Clear** button.
Global trigger selection

Select this checkbox to trigger keyboard commands even when PlayIt Live is not selected.

Please think carefully when choosing keyboard shortcuts. For example, it is not recommended to configure Space Bar as a keyboard shortcut. This could interfere when you are typing into the search box and inadvertently trigger an action.
The Advanced Tab shows settings you can change that modify more technical parts of the system.

**Playback buffer length**

- **Playback Buffer Length:** 500 ms

Increasing the playback buffer length decreases the chance of the sound breaking up on slower computers, but also increases latency when processing audio. A restart of PlayIt Live is required to apply the change.
Various elements of PlayIt Live can be administered from the Manage menu.

Apart from Scheduled Events, it is not possible to manage data while connected to PlayIt Manager.
Tracks

Tracks represent audio files that can be imported into PlayIt Live. With each track, additional information is stored to assist playback and announcing on air. This information includes:

- **Artist:** The performer of the track, typically a singer or band.
- **Title:** The name of the track.
- **Out Cue:** The style at which the track ends, for example, fade out; or sustain.
- **Album:** The album the track appears on.
- **Genre:** The category that identifies the type of music.
- **Year:** The year the track was released.
- **Tags:** A tag is a keyword or term that helps to describe the track. Tags can be used in track group filters.
- **Comments:** A free-text field allowing you to enter any descriptive text about a track. This can also be useful for describing where and when the track charted. This is displayed on the playout log on the main interface when clicking on an item.
- **Sweeper?:** Whether the track is a sweeper. A sweeper is a track that can be played over the start of the intro of another song. It is typical dry (no background music) so it does not clash with the track it is playing over.
- **No Fade?:** Tracks marked with No Fade will not be faded when the Cue Out point of the track is reached. This is typically used if the track is already fading.
- **Cue In:** The position in the track where a player should start playing. This is typically where the silence ends at the start of the track and the audible audio begins.
- **Intro:** The position in the track where the vocals begin. This can be used by the on-air presenter / DJ to 'hit the vocals'.
- **Cue Out:** The position in the track where it is considered to be finished. If a track is fading out, this should be shortly before the end of the fade. When the cue out point is hit in Live-Assist mode, this will cause the track will segue into the next.
Manage Tracks Window

The Managed Tracks window shows all tracks imported into PlayIt Live. Tracks imported into PlayIt Live can be used from the Track List on the right-hand side of the main window.

1. **Track Group selector**

To filter the track list by track group, select the track group from the drop down. The track list will show only tracks that exist in the selected track group. Track groups can be managed from Manage > Track Groups.

2. **Track search box**

Use the search box to filter the track list. When text is entered into the search box the track list will show only track titles that contain the entered text. To clear the search click the 'x'.

3. **Track list**

The track list shows the Artist, Title, Intro, Duration and Path of all the tracks in the database. Double-click an entry to begin editing a track and launch the *Edit Track Window*. Changes will not be saved until you click the Apply or OK button.
To delete a track click the delete button. Changes will not be saved until you click the Apply or OK button.

To delete all tracks from the list, select the list and press **CTRL+A** to select all the tracks. Press the **Delete** key to remove the tracks. A confirmation window will be shown to confirm your changes.

Click the **Add New** button to begin adding new tracks to the database and launch the **Add New Tracks Wizard Window**.

Click the **Edit** button to begin editing the selected track. This will launch the **Edit Track Window**. You can also **bulk edit tracks** by selecting multiple tracks with CTRL or SHIFT and clicking the **Edit** button.

Click the **OK** button to save changes and close the Manage Tracks window.

Click the **Cancel** button to discard any changes and close the Manage Tracks window.

Click the **Apply** button to save changes without closing the Manage Tracks window.
The track editor is used to change the information stored on each track imported into PlayIt Live.

**File path**

File Path: E:\Music\A-Ha - Take On Me.mp3

This displays the location of the audio file on the file system. This cannot be changed once the track has been added.
Track information

This area allows you to change the information stored on the track. Artist, Genre and Tags information will attempt to auto complete if there is similar information on other tracks in order to help keep data consistent.

Play and Stop buttons

Use the **Play** and **Stop** buttons to listen to the track. The audio device (sound card) used to play back the audio can be configured in Settings.

Cue In controls

The Cue In point is the position in seconds where the track should be started by a player. Use the **Set** button while listening to the track to set the point to the current position. Use the **Test** button to listen to the track from the set position.

Intro controls

The Intro point is the position in seconds where the vocals start on the track. This is counted down by the players on the main window. Use the **Set** button while listening to the track to set the point to the current position. Use the **Test** button to listen to the track from the set position.
The Cue Out point is the position in seconds where the track is considered to have finished. When this point is hit in Live-Assist mode, the players will begin fading out this track and start playing the next. The players count down the remaining time to this point. Use the **Set** button while listening to the track to set the point to the current position. Use the **Test** button to listen to the track from the set position.

Click the **Analyse** button to automatically detect the Cue In and Cue Out points based on the silence at the start and end of the track. The sensitivity of the analysis can be configured from **Settings**.

The waveform shows the volume of the audio track over time. Overlayed on the waveform are the **Cue In** (grey), **Intro** (blue) and **Cue Out** (pink) points that are set above. While playing, click and drag over the track to seek to a different position in the track.

Use the navigator to easily move to the previous and next track displayed in the list. Note, before moving between tracks, any changes to the current track will be saved.

Click the **Save Track** to confirm changes to the current track.

Click the **Close** button to discard changes to the current track.
Bulk Editing Tracks

It is possible to bulk edit tracks to update fields on multiple tracks at once. You can select multiple tracks by holding the CTRL or SHIFT keys and clicking on track rows:

Then click the **Edit** button.

The Bulk Edit window will be shown allowing you to edit multiple tracks at once. Simply tick the fields you want to change and enter the new value, e.g. Genre: Pop:
You can also bulk analyse cue points in tracks by clicking on the Analyse button.

Once finished, click the Save Tracks button.
The Add New Tracks Wizard is designed to streamline the process of adding tracks to PlayIt Live.

1. **From individual files**
   - When you click Next you will be asked to select the file or files you wish to add.
   - Click this option to select tracks from individual files. When you click Next you will be prompted to select files to add.

2. **From a folder**
   - When you click Next you will be asked to select the folder you wish to add files from.
   - Click this option to select tracks from a folder. When you click Next you will be prompted to select a folder to add files from.

3. **Back button**
   - The Back button is enabled once beyond the first step of the wizard. Click the Back button to make changes in previous steps of the wizard.
4 **Next button**

Click the **Next** button to move to the next step in the wizard.

5 **Cancel button**

Click the **Cancel** button to exit the wizard.
Additional Options Section

Please choose from the additional options below:

1. **Source selection**
   - Folder: E:\Music\Songs
   - The current source that was selected in the previous step, either a folder or the number of files.

2. **Include sub folders**
   - Include sub folders
   - If a folder was selected in the previous step, check this box to include sub folders when scanning for track files.

3. **Analyse silence**
   - Analyse the silence in these tracks, setting appropriate cue in and out points.
   - Check this box to analyse silence at the start and end of tracks to automatically determine the Cue In and Cue Out points. The parameters for the silence analysis can be configured from **Settings**.

4. **Duplicate handling**
   - Replace any tracks with the same file path
   - Skip any tracks with the same file path
   - Duplicate any tracks with the same file path
Duplicate handling

The duplicate handling section determines how files with the same file path are handled when processing new tracks. This section is unavailable if there are no tracks currently in the system.

Replace any tracks with the same file path
If a file is found that has the same path as a track in the system, it will be overwritten by the new track file.

Skip any tracks with the same file path
If a file is found that has the same path as a track in the system, it will be ignored and will not change the existing track already added to PlayIt Live.

Duplicate any tracks with the same file path
If a file is found that has the same path as a track in the system, it will be added again, resulting in two instances of the same track in the system. This is the behaviour found in versions of PlayIt Live, prior to version 1.10.
The Progress section shows the progress of the tracks being processed.

1. **Current track file path**
   
   ![Image of current track file path]
   
   The current track being processed.

2. **Artist and title**
   
   ![Image of artist and title]
   
   The artist and title read from the processed track file. This is read from the embedded tag information within the file. If this information is missing, the artist and track are determined from the filename in the format `Artist - Title.ext` where `ext` is the file extension.

3. **Overall progress**
   
   ![Image of overall progress]
   
   The overall progress of the adding tracks process. This will also indicate if any files have been skipped as they are not valid audio files.
The Review section is designed to allow you to review tracks before they are added to the system.

1. **Track list**
   - This list includes all the tracks that were processed by the wizard.
   - If a track is checked, it is marked to be added to the system at the end of the wizard. Un-check this box to prevent a track from being added.

2. **Track check box**
   - If a track is checked, it is marked to be added to the system at the end of the wizard. Un-check this box to prevent a track from being added.

3. **Track editor**
   - See: Edit Track Window
The final section of the wizard is the Group section. Here you can add the processed tracks to an existing group, a new group or leave them in the All Tracks group. Click Finish to add the tracks to the system.

1. **Leave in All Tracks group selection**
   - Do not add these tracks to a particular group.
     - These tracks can be found in the All Tracks group.

   Select this option to prevent the processed tracks from being added to a particular track group. By default, they will appear in the All Tracks group.

2. **Add to existing group selection**
   - Add all these tracks to an existing group:
     - No Groups

   Select this option to add the processed tracks to an existing track group. Select the track group from the dropdown.

3. **Add to new group selection**
   - Add all these tracks to a new group:
     - New Group Name: Songs

   Select this option to add the processed tracks to a new track group. Enter the name of the new group into the text box.
Click the Finish button to complete the track adding process and add the tracks to the system.
**Track Groups**

As the name suggests, Track Groups are used to group tracks by certain criteria. There are three types of track group:

- **Listed:**
  Manually select a list of tracks to add to the group.

- **Filtered:**
  Select a set of filters to dynamically select the tracks based on information stored on the track.

- **Grouped:**
  Combine multiple track groups into one track group.

Track groups are used on the main interface to filter tracks in the track list. They are also used in playout policies, playout pattern, and clocks.

### Customising the playout log on the main interface with track groups

It is possible to change the icon and colour of a track on the playout log on the main interface. When editing a track group, you can optionally select an icon and colour for the track group. There are a number of built-in icons but it is possible to add your own.

To add your own icons, go to the `C:\ProgramData\PlayIt Live\icons` folder on your computer. Please note that the `C:\ProgramData\` is a hidden folder so you should type the full path into Window Explorer or the Run window:

![Run window](image)

The built-in icons are 256x256 PNG icons with transparency. To add your own icons to PlayIt Live, simply add the images to this folder. PlayIt Live uses the filename without extension to store which icon is associated with each track group. Therefore you should refrain from using the same filename with different extensions for different icons. You should also refrain from prefixing your images with `playit-`. Anything with this prefix could be removed or overwritten by a new version of PlayIt Live. Once you have added your icons to the folder they will be visible for use in PlayIt Live.
The Manage Track Groups window lists all the track groups in the system.

**Track group list**

Displays the Name, Type, Track Count, and Hidden state of each track group. Double-click an entry in the list to begin editing and launch the edit window. Depending on the type, this could be the Edit Listed Track Group Window, Edit Filtered Track Group Window, or Edit Grouped Track Group Window.

**Delete button**

Click the **Delete** button to delete the track from the system.

**Hidden check box**

Check the **Hidden** check box to hide the Track Group from the main interface Track Group selector.

**Add New button**

Click the **Add New** button to begin adding a new track group to the system and launch the Choose Track Group Type Window.
Click the Edit button to begin editing the selected track group and launch the edit window. Depending on the type, this could be the Edit Listed Track Group Window, Edit Filtered Track Group Window, or Edit Grouped Track Group Window.

Click the OK button to save changes.

Click the Cancel button to discard changes.

Click the Apply button to save changes without closing the window.
Choose Track Group Type Window

Choose the type of track group you would like to create:

1. Listed Track Group
   Choose a specific list of tracks to use for this track group.
   Select this option to create a Listed Track Group. Then click OK to launch the Edit Listed Track Group Window.

2. Filtered Track Group
   Create a set of filters to use for this track group.
   Select this option to create a Filtered Track Group. Then click OK to launch the Edit Filtered Track Group Window.

3. Grouped Track Group
   Choose a list of existing track groups to combine into this track group.
   Select this option to create a Grouped Track Group. Then click OK to launch the Edit Grouped Track Group Window.

4. OK button
   Click OK to continue creating a track group of the selected type.

5. Cancel button
   Click Cancel to stop creating a new track group.
Edit Listed Track Group Window

**Track Group name**

Name: **Jingles**

The name of the track group.

**Track search box**

Enter text into the search box to filter the track list. See: Track search box.

**Track list**

List of tracks not already in the track group.

**Add to track group**

Click the > button to add the selected track group from the track list to the track group track list.
Track group track list

List of tracks in the track group.

Remove from track group

Click the < button to remove the selected track group from the track group track list.

Colour

Tick the Colour box to show a colour for any tracks in this track group when they are shown on the playout log on the main interface. Click in the colour box to change the colour.

Icon

Tick the Icon box to show an icon for any tracks in this track group when they are shown on the playout log on the main interface. Click in the icon box to change the icon, the Select Icon window will be shown:

To add your own icons, see the Customising the playout log on the main interface with track groups section.
Priority

The priority is used to determine which track group is used when displaying a track on the playout log on the main interface that appears in multiple track groups. The track group with the highest priority will be used when displaying the colour or icon.

OK button

Click the OK button to confirm changes to the track group.

Cancel button

Click the Cancel button to discard changes to the track group.
The Filtered Track Group window allows you to create dynamic track groups using filters. The above track group filters tracks by years between 1980 and 1990 (i.e. year greater than or equal to 1980 and year less than 1990) to form the 1980s track group.

1. **Track group name**

   The name of the track group

2. **Add filter button**

   Click the *Add* button to add a new filter condition

3. **Remove filter button**

   Click the *Remove* button to remove the filter condition

4. **And / Or selector**

   To filter tracks by more than one condition, use the And/Or selector to choose how to combine the filters. The *And* operator selects tracks that match *both* the first and the second condition. The *Or* operator selects tracks that match *either* of the first or the second condition.

5. **Open parentheses**

   Use parentheses to form complex filters. To the up and down arrows to increase and decrease the number of parentheses.

6. **Field selector**

   Use the dropdown to select the field you wish to filter by.
Operation selector

Use the dropdown to select the filter operation.

Filter value

1990

Use the text box to enter the value to filter by.

Close parentheses

Use parentheses to form complex filters. To the up and down arrows to increase and decrease the number of parentheses.

Matched tracks

Tracks matched by this filter:

<table>
<thead>
<tr>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ac - Hells Bells</td>
</tr>
<tr>
<td>A-ha - Take On Me</td>
</tr>
<tr>
<td>Ashford &amp; Simpson - Solid</td>
</tr>
<tr>
<td>Barbra Streisand - Woman In Love</td>
</tr>
<tr>
<td>Barry Manilow - Could It Be Magic (1993 Version)</td>
</tr>
<tr>
<td>Belinda Carlisle - Heaven Is A Place On Earth (Live)</td>
</tr>
<tr>
<td>Belinda Carlisle - Leave A Light On</td>
</tr>
</tbody>
</table>

As the filter is updated the Matched tracks list will be updated to reflect the tracks that will be matched the current filter.

Colour, Icon and Priority

- Colour: [Blue](click to change)
- Icon: [Heart](click to change)
- Priority: [1](click to change)

See Listed Track Group settings
**Edit Grouped Track Group Window**

1. **Track group name**
   - Name: Jingles & Promos
   - The name of the track group.

2. **Invert selection checkbox**
   - Include only tracks not found in the selected groups
   - If this checkbox is checked, the tracks in this group will be the inverse of the selected groups. That is, this track group will include only tracks that do **not** appear in the selected track groups.

3. **Track group selections**
   - List all the track groups in the system. Click a checkbox to include the selected track group in this track group.

4. Colour, Icon and Priority
   - Colour: (click to change)
   - Icon: (click to change)
   - Priority: 

5. OK button
6. Cancel button
**Colour, Icon and Priority**

- Colour: ▢ (click to change)
- Icon: ★ (click to change)
- Priority: □ □ □

See [Listed Track Group settings](#)

**OK button**

Click the **OK** button to confirm changes to this track group.

**Cancel button**

Click the **Cancel** button to confirm changes to this track group.
Monitored Folders

Monitored Folders can watch the state of a folder (and optionally its sub-folders) for new, updated or deleted track files. Monitored Folders can be accessed via Manage > Monitored Folders.

When a file is added to the folder, it will be added to the PlayIt Live database if it is a valid track file. The track file can also be automatically analysed for cue points and added to a track group.

When a file is updated in the folder, it will be updated in the PlayIt Live database, updating the duration, cue points and any file metadata contained within the file if desired.

When a file is deleted from the folder, it will be deleted from the PlayIt Live database.

Monitored folders work by periodically scanning for changes in the folder. Folders with a large number of files or sub-folders will take longer to scan. For this reason, do not use C:\ as the folder to scan for changes to every file on your computer. This will likely never complete. Choose a folder where you know where audio files are.

Use Monitored Folders if you have dynamic content, e.g. news or weather, from a folder such as Dropbox. Create a Monitored Folder with a Path to the shared Dropbox folder to pick up changes from the Dropbox folder.

You can check the Monitored Folders Status window for recent changes to your monitored folders.
From the Manage Monitored Folders window you can see the list of existing Monitored Folders.
Edit Monitored Folder Window

Path

The path to the folder you want to monitor.

Include sub-folders

If checked, sub-folders of the folder will also be scanned. Avoid folders with a large number of sub-folders as this will take a long time to scan.

Analyse cue points

If checked, when a track file is added the cue points of the track will be analysed.

Re-analyse cue points

If checked, when a track file is updated the cue points of the track will be re-analysed. Do not use this option if you manually set cue points as these will be overwritten.

Update track fields

If checked, when a track file is updated the fields of the track will be updated from the file. Do not use this option if you manually change the track fields as these will be overwritten.

Add tracks to track group

If checked, new tracks will be added to the selected track group. Tracks will not be re-added to this track group if they are subsequently removed from the group.
If checked, the monitored folder will be disabled and will not be monitored.
Logged Tracks

Logged tracks are tracks that have been logged in the past by PlayIt Live. Stored with each track is a timestamp to tell when it was played.

In Decks Mode a track is logged if it is played for more than 75% of its duration.

In Live-Assist Mode a track is logged if it has started playing and exists in the playout log in the past.
The Logged Tracks window show a list of the recently logged tracks. It is possible to export the visible list to CSV format to import into Excel or another spreadsheet application for reporting.

1. **Past 24 hours filter selection**
   - Filters the logged tracks list to those logged in the past 24 hours.

2. **Past 7 days filter selection**
   - Filters the logged tracks list to those logged in the past 7 days.

3. **Past 30 days filter selection**
   - Filters the logged tracks list to those logged in the past 30 days.

4. **Custom date filter selection**
   - Filters the logged tracks list by a custom date range. Select the dates using the calendar drop down and select the time.

5. **Logged track list**
   - Displays the list of logged tracks.
**Export to CSV button**

Click the **Export** button to export the current visible logged track list to CSV (comma separated values) format. This format can be imported into spreadsheet applications for reporting purposes.

**Close button**

Click the **Close** button to close the Logged Tracks window.
Playout Policies

Playout policies define a set of rules to ensure the correct tracks are played. Playout policies restrict artists and tracks from being repeated too often. They can be filtered by track group.

For example, it is possible to ensure that tracks in a track group of Songs are not repeated for at least 2 hours while ensuring tracks in a track group of Jingles are not repeated for only at last 10 minutes.
Manage Playout Policies Window

1. **Playout policy list**
   - Lists all the playout policies in the system. Double-click an entry to begin editing and launch the Edit Playout Policy Window.

2. **Delete button**
   - Click the Delete button to remove the playout policy from the system.

3. **Add New button**
   - Click the Add New button to begin adding a new playout policy to the system and launch the Edit Playout Policy Window.

4. **Edit button**
   - Click the Edit button to begin editing the selected playout policy and launch the Edit Playout Policy Window.

5. **OK button**
   - Click the OK button to save changes.

6. **Cancel button**
   - Click the Cancel button to discard changes.

Click the Add New button to begin adding a new playout policy to the system and launch the Edit Playout Policy Window.
Click the **Apply** button to save changes without closing the window.
**Edit Playout Policy Window**

1. **Track separation time**
   
   Do not play the same track for at least 2 hours.

   Use the up and down arrows to change the minimum number of hours/minutes that should pass before a track is played again. Use the dropdown to change the time unit from hours to minutes.

2. **Artist separation time**
   
   Do not play the same artist for at least 1 hour.

   Use the up and down arrows to change the minimum number of hours/minutes that should pass before an artist is played again. Use the dropdown to change the time unit from hours to minutes.

3. **Specific groups filter**

4. **Playout policy name**

5. **OK button**

6. **Cancel button**
Specific groups filter

- Apply this policy to specific track groups (leave unchecked for All Tracks)

- Decade: 1980s
- Decade: 1990s
- Decade: 2000s
- Decade: 2010s
- Noughties and Tens
- PlaylistA

Check the checkbox to ensure this playout policy is only applied to the selected tracks. Leave the checkbox unchecked to apply the policy to all tracks.

Playout policy name

- Name: Do not repeat same track for 2 hours, same artist for 1 hour

The name of the playout policy.

OK button

- Click the OK button to confirm changes to the playout policy.

Cancel button

- Click the Cancel button to discard changes.
Playout Pattern

The playout pattern is the repeated pattern of track groups that are used by the playout log. For example, a playout pattern can be configured with the following track groups:

- Songs
- Jingles
- Promos

which will result in Songs, Jingles and Promos being repeated back to back over the hour.
Manage Playout Pattern Window

1. **Track group list**
   - Lists all tracks that can be added to the playout pattern.

2. **Add to playout pattern button**
   - Click the > button to add the selected track group from the Track group list to the playout pattern.

3. **Playout pattern track group list**
   - Lists all the tracks in the playout pattern in order.

4. **Remove from playout pattern button**
   - Click the < button to remove the selected track group from the playout pattern.
Move up button
Click the Up button to move the selected playout pattern track group up the list.

Move down button
Click the Down button to move the selected playout pattern track group down the list.

OK button
Click the OK button to save changes to the playout pattern.

Cancel button
Click the Cancel button to discard changes.
Scheduling

It is possible to schedule items in the playout log for the future. This allows for future planning and to see what tracks will play ahead of time.

Typically, hour-long templates called clocks are created and then scheduled to individual hours. The playout log can then be scheduled and set in time. The playout log can be tweaked by the user for their needs.

A detailed video demonstrating the scheduling features in PlayIt Live can be found on the PlayIt Software YouTube channel: https://www.youtube.com/watch?v=14Ksmcf5Cy8
Clocks

Clocks are hour-long templates used to define how an hour of playout content should sound. When a clock is scheduled, the playout log will generate items to schedule based on the clock item. The clock can have a number of clock item types:

- **Track**: The playout log scheduler will always insert the selected track in this position in the playout log.
- **Track Group**: The playout log scheduler will randomly choose a track from the selected track group to insert in this position in the playout log. When scheduling the playout log, any playout policies will be taken into account.
- **Fixed Time Marker**: The playout log scheduler will insert a fixed time marker in this position in the playout log.
- **Break Note**: The playout log scheduler will insert a break note to include in this position in the playout log.
- **Voice Track**: The playout log scheduler will insert a voice track placeholder where the user can record a voice track from the main interface.
- **Remote URL**: The playout log scheduler will insert a remote URL item in this position in the playout log.
- **Aux Input**: The playout log scheduler will insert an aux input item, in this position in the playout log. An aux input item will play a live feed from an input on your sound card.
Manage Clocks Window

1. **Clocks list**
   - Shows the list of clocks in the system. Double click an entry to begin editing and launch the Edit Clock Window.

2. **Delete button**
   - Click the Delete button to remove a clock from the system.

3. **Clone button**
   - Click the Clone button to create a copy of the selected clock. This is useful if you want to make small adjustments to existing clocks without having to rebuild the entire clock.

4. **Add New button**
   - Click the Add New button to begin adding a new clock and launch the Edit Clock Window.
5 **Edit button**

Click the **Edit** button to begin editing the selected clock and launch the [Edit Clock Window](#).

6 **OK button**

Click the **OK** button to save changes.

7 **Cancel button**

Click the **Cancel** button to discard changes.

8 **Apply button**

Click the **Apply** button to save changes without closing the window.
**Clock name**
The name of the clock.

**Clock item list**
The list of items in the clock. Each item features its approximate play time, type, settings, segue flag and notes. To duplicate an item, select it and press **CTRL+D**. Click and drag items to re-order them in the list.

**Play time**
The approximate play time of a clock item is determined from the sum of the all the previous item durations. The duration of each item varies on the choice of settings - the duration of a track group item is determined from the average duration of all the tracks in the group. A fixed time marker will cause the play time to reset to the fixed time.

**Clock item type**
The type of the clock item.

**Clock item settings**
The settings of the clock item. Click the edit icon to launch the edit settings window. Depending on the item type this will either launch the **Edit Track Settings Window, Edit Track Group Settings Window, Edit Break Note Settings Window, Edit Fixed Time Marker Settings Window, Edit Voice Track Settings Window, Edit Remote URL Settings Window** or **Edit Aux Input Settings Window**.
Segue?

When this checkbox is checked it will mark the scheduled playout log item with the same segue selection.

Segue style

Segue style to apply to the scheduled playout log item. If '--' then the default will be used. For tracks marked as sweeper the default from Settings will be used.

Notes

Click the edit item to add notes about this clock item. This is purely for informational purposes.

Delete button

Click the Delete button to remove the clock item.

Add button

Click the Add button to add a clock item to the end of the list.

OK button

Click the OK button to confirm changes to the clock.

Cancel button

Click the Cancel button to discard changes.
Edit Track Settings Window

1. **Track Group selector**
   - Use the dropdown to filter the track list by track group.

2. **Track search box**
   - Use the search text box to filter the track list by artist and title.

3. **Track list**
   - Select the track you wish to include by clicking it in the list. Double click the track in the list to immediately confirm your selection.

4. **OK button**
5. **Cancel button**
4 **OK button**

Click the **OK** button to confirm your selection.

5 **Cancel button**

Click the **Cancel** button to discard your selection.
Select the track group you wish to include in the clock. Double click the track group in the list to immediately confirm your selection.

Click the **OK** button to confirm your selection.

Click the **Cancel** button to discard your selection.
Edit Break Note Settings Window

1. **Duration selection**
   
   Use the up and down arrows to change the duration of the break note.

2. **Notes**
   
   Use the Notes text to indicate the purpose of the break to the user.

3. **OK button**
   
   Click the **OK** button to confirm your changes.

4. **Cancel button**
   
   Click the **Cancel** button to discard your changes.
**Edit Fixed Time Marker Settings Window**

- **Fixed time selection**: Use the up and down arrows to select the fixed time for this marker. The fixed time indicates the number of minutes and seconds within the current hour to fix the time. For example, within the 20:00 (8pm) hour, a fixed time marker of --:15:00 would fix the time around 20:15:00 (8:15pm).

- **Hard type selection**: Select this option to select a hard fixed time marker. A hard fixed marker will cause any playing items to immediately fade out and stop and advance to the next playout log item after the fixed time marker.

- **Soft type selection**: Select this option to select a soft fixed time marker. A soft fixed marker will cause any playing items to finish before advancing to the next playout log item after the fixed time marker.

- **'Not Before' type selection**: Ensures that no succeeding items are started until at least this fixed time has passed.

---

**Fixed time selection**

Use the up and down arrows to select the fixed time for this marker. The fixed time indicates the number of minutes and seconds within the current hour to fix the time. For example, within the 20:00 (8pm) hour, a fixed time marker of --:15:00 would fix the time around 20:15:00 (8:15pm).

**Hard type selection**

Select this option to select a hard fixed time marker. A hard fixed marker will cause any playing items to immediately fade out and stop and advance to the next playout log item after the fixed time marker.

**Soft type selection**

Select this option to select a soft fixed time marker. A soft fixed marker will cause any playing items to finish before advancing to the next playout log item after the fixed time marker.
'Not Before' type selection

Select this option to select a 'not before' fixed time marker. A 'not before' fixed time marker ensures that items following this marker will not be played until at least the fixed time. Not Before fixed time makers are automatically inserted when a new hour is scheduled.

OK button

Click the OK button to confirm your changes.

Cancel button

Click the Cancel button to discard your changes.
**Edit Voice Track Settings Window**

1. **Voice Track Placeholder Duration**
   - **Voice Track Placeholder Duration**: 1m 0s
   - The intended duration of the voice track. This is used to estimate the duration of the track in the log.

2. **OK button**
   - Click the OK button to confirm your changes.

3. **Cancel button**
   - Click the Cancel button to discard your changes.
Remote URL items can play audio from the internet or your internal network.

It is possible to choose either a File or Live Stream:

A File URL typically refers to a static file located on a server which is downloaded by PlayIt Live when it is loaded into a player. Remote files are intended to be a fixed length duration and this must be provided to PlayIt Live in order to ensure the item is scheduled with the correct length (as this is not known until load time).

A Live Stream URL typically refers to an audio stream provided by a streaming media server such as Icecast or Shoutcast and could be an internet radio station or a remote DJ stream. PlayIt Live assumes the live stream will run forever so will attempt to restart the stream if the connection is dropped. PlayIt Live will play the live stream until the specified duration has elapsed. Live streams can also be stopped manually, or by using a hard fixed time marker.

1. **Title**
   Title: News
   The title of the stream for your reference.

2. **URL**
   URL: http://news.playitsoftware.com/news.mp3
   The internet address of the file or stream to play. This should refer to a file or an internet stream. Please note that playlist files (m3u or pls) not supported as they are actually playlist text files that contain the stream to play.

3. **Type**
   Type: File
   The type of audio the URL refers to.
Duration

For file URLs, this is the expected duration of the file used for scheduling. Use the Get Duration From File button to automatically fetch the duration from the remote file. For live stream URLs, this is the duration the live stream will play for.

OK button

Click the OK button to confirm your changes.

Cancel button

Click the Cancel button to discard your changes.

When Live Stream is selected the duration refers to the duration for which the live stream will play.
Aux Input items can play live audio from an external input devices on your computer. This is typically used to pull in a live news feed from an external provider such as IRN/Sky News over satellite.

1. **Title**
   - Title: News
   - The title for the item. This is shown on the live log.

2. **Input device**
   - Input device: Line 1/2 (3-M-Audio Fast Track Ultra)
   - The input device to pull the audio from. This can be a stereo or a mono device. Please note that the mono channel of a device cannot be used at the same time if it is used within a stereo channel.

3. **Duration**
   - Duration: 00h 02m 00.000:
   - The duration to play the audio for. The above example will play the live audio feed for 2 minutes and then stop.
**Scheduling Clocks**

Clocks can be assigned to individual hours of the day throughout the week. The playout log scheduler will use clocks assigned to hours to determine the items that are scheduled as part of the playout log.
To schedule a clock, drag off a free slot and select a clock from the **Select Clock Window**.

1. **Previous week button**
   - Click the **Previous week button** to move the schedule calendar back a week.

2. **Next week button**
   - Click the **Next week button** to move the schedule calendar forward a week.

3. **Hour heading**
   - The heading for the hour row in the grid. The current hour is shown in red.

4. **Day heading**
   - The heading for the day column in the grid. The current day is shown in red.
Double click the schedule item in the calendar to begin editing it and launch the Edit Schedule Item Window. If the schedule item is a recurring one the Edit Recurring Item Window will first be shown.

Click the Add New button to schedule a new clock and launch the Select Clock Window.

Click the OK button to confirm changes to the schedule.

Click the Cancel button to discard changes.
The Select Clock window is shown when you click the Add New button on the Schedule Clocks window or when you click the Clock name on the Edit Schedule Item window.

**Clock list**

Click the item to select the clock you wish to schedule. Double-click the item to immediately select the clock and return to the Edit Schedule Item Window.
OK button

Click the **OK** button to select the clock from the list and return to the [Edit Schedule Item Window](#).

Cancel button

Click the **Cancel** button to close the window.
Inclusive of this time

1. **Scheduled clock**
   
   Scheduled Item: **00s Hour**
   
   The clock that is being scheduled. Click the underlined name of the clock to select a different clock and launch the Select Clock Window.

2. **Start time**
   
   Start: **13 April 2014** 19:00
   
   The start time of the scheduled clock. For recurring (repeated) scheduled clocks this indicates the first occurrence.

3. **Finish time**
   
   Finish: **13 April 2014** 20:00
   
   The finish time of the scheduled clock. Clocks are restricted to a duration of exactly one hour.

4. **Repeat checkbox**
   
   **Repeat**
   
   Use the repeat checkbox to repeat this scheduled clock multiple times in the future.

5. **Repeat period**
   
   **Repeats:** Daily
   
   Use the repeat period dropdown to select how often the scheduled clock repeats over time.
Repeat every...

Use the repeat every... dropdown to select how often the scheduled clock repeats over time.

Repeat on...

Only available when Weekly is selected as the repeat period, use the repeat on... checkboxes to select which days of the week the scheduled clock will repeat on.

Repeat at...

Only available when Daily is selected as the repeat period, use the repeat on... options to select which hours the scheduled clock will repeat on. Click the All option to select all hours.

Repeat until...

Select Forever to repeat this scheduled clock indefinitely. Select This Time to repeat this scheduled clock until the selected time (inclusive).

OK button

Click the OK button to confirm changes.

Cancel button

Click the Cancel button to discard changes.
The Edit Recurring Item Window will be shown when you try and edit or delete a recurring schedule item. This allows you decide if you wish to edit only the occurrence that you clicked on; the occurrence you clicked on and all future occurrences; or all occurrences.
**Playout Log**

The playout log indicates past and future events that are scheduled to take place from hour to hour. Based on the clocks that are scheduled via the *Schedule Clocks Window* the playout log scheduler will generate playout log items matching the clock items. If a clock has not been scheduled for an hour, the playout pattern will be used to generate the playout log items.
Range start time selector

Use the date and time selectors to show in the playout log list only items that begin on or after the selected time.

Range end time selector

Use the date and time selectors to show in the playout log list only items that begin before the selected time.

Import button

Click the **Import** button to import a log generated from an external scheduler. See Import Playout Log Window.

Schedule button

Click the **Schedule** button to generate playout log items based on the clocks that have been created via the Manage Clocks Window and scheduled via the Schedule Clocks Window. If a clock has not been scheduled for a given hour slot, the playout pattern will be used.

Unschedule button

Click the **Unschedule** button to remove all the visible items from the list.
The playout log list shows all the items currently scheduled for the selected time range. Playout log items are grouped by hour and are ordered by the position they appear in the hour. A fully scheduled hour and more information on using list can be found at Edit Playout Log Window (Scheduled).

**Add button**

Click the **Add** button to add a new playout log item below the selected item.

**OK button**

Click the **OK** button to save all changes made to the playout log and return to the main window.

**Cancel button**

Click the **Cancel** button to discard all changes made to the playout log and return to the main window.

**Apply button**

Click the **Apply** button to save all changes made to the playout log but leave this window open.
Edit Playout Log Window (Scheduled)

1. **Hour group**
   
   - Sunday 04 June 2017 18:00
   
   Each playout log item belongs to an hour group.

2. **Play time**
   
   - 18:00:00
   
   Each playout log item has an approximate play time. Assuming previous hours do not over or under run this time should be accurate. The Played? column will display **Y** when the item has been played.

3. **Hour position**
   
   - 2
   - 3
   
   The position in the hour. The position can be changed by dragging the item up or down the list.

4. **Item type**
   
   - **Track:** Choose a specific track to play.
   - **Fixed Time Marker:** Choose a fixed time marker to keep to time within the hour.
   - **Break Note:** Choose a break note to include in this position in the playout log.
   - **Voice Track:** Choose a voice track to insert a voice track placeholder and record a voice track via the main interface.
   - **Remote URL:** Choose a remote URL file or stream to include in this position in the log.
   - **Aux Input:** Choose an external audio input to include in this position in the log.
The settings for the playout log item. Click the pencil icon to begin editing and launch the settings window. The settings windows used for the playout log item settings are similar to the clock item settings: Edit Track Settings Window, Edit Break Note Settings Window, Edit Fixed Time Marker Settings Window, Edit Voice Track Settings Window or Edit Remote URL Settings Window or Edit Aux Input Settings Window.

Check the segue checkbox to ensure that, when playing the item, the player automatically advances to the next item when it reaches the out point.

The segue style to use for the playout log item. More information about segue styles can be found on the Segue Editor section.

Click the Delete button to remove the item from the playout log.
You can use the Import Playout Log window to import logs from an external scheduler. Currently the import feature supports M3U format and SS32 (Scott Studios) format. When an import file is selected, PlayIt Live will attempt to automatically determine the format (from the extension) and the date range from the filename (in the format YYMMD or YYMMDDHH).

The M3U Playlist format is simply a list of audio files in a text file. To separate the playlist file into hours, a # Hour: comment can be used indicate which hour the track file belongs in. An example of an M3U Playlist file supported by PlayIt Live is below:

# Hour: 00:00
G:\PlayIt User\Music\Jingles\Publicise Your Event ID.mp3
G:\PlayIt User\Music\Songs\Sam and the Womp - Bom Bom.mp3
G:\PlayIt User\Music\Songs\Fenech-Soler - All I Know.mp3
...
# Hour: 01:00
G:\PlayIt User\Music\Jingles\City Locations ID A.mp3
G:\PlayIt User\Music\Songs\Lianne La Havas - Is Your Love Big Enough.mp3
G:\PlayIt User\Music\Songs\Of Monsters and Men - Mountain Sound.mp3
G:\PlayIt User\Music\Jingles\Contact Studio On Text & Email ID.mp3

Special items, such as fixed time markers, can also be added via the M3U Playlist format. This can be done by adding a line as follows:

# Fixed Time Marker: Type=Hard; TargetTime=3m02s - Hard fixed time marker at 3 minutes 2 seconds past the hour
# Fixed Time Marker: Type=Soft; TargetTime=3m - Soft fixed time marker at 3 minutes past the hour
# Fixed Time Marker: Type=NotBefore; TargetTime=5s - Not Before fixed time marker at 5 seconds past the hour

# Break Note: Duration=1m1s; Notes="News on the hour" - Break note lasting 1 minute and 1 second with the notes News on the hour

# Voice Track Placeholder: Duration 1m - Voice track placeholder lasting 1 minute.

# URL: Duration=1m; Title="News"; URL="http://www.mywebsite.com/news.mp3";
# Type=File - Example of a file URL
# URL: Duration=60m; Title="Simulcasted show"; URL="http://www.mywebsite.com/live";
# Type=Live - Example of a live URL
The SS32 (Scott Studios) format is another format that can be exported by an external scheduler. Please contact support if you wish to learn more about this.

When a file is imported, the entire log for the date range will be cleared and replaced with the imported file. Click the Start Import button to import the file and review the updated log before applying the changes from Playout Log window. If there are any errors processing the imported log file, you will be prompted to view these when the import process has completed.

1. **Import file**
   - **Import file:** G:\Play\User\Playlists\16102300.m3u
   - The file to import.

2. **Format**
   - **Format:** M3U Playlist
   - The format of the file to be imported.

3. **Base audio folder**
   - **Base Audio Folder:**
   - The base audio folder to be used by the importer. This is optional, and used with the SS32 format. The SS32 format can contain relative paths to files, so the base audio folder is used to create an absolute path to the file.

4. **Date range**
   - **Date range:** 23 October 2016 00:00 to 24 October 2016 00:00
   - The date range to import into. Any existing log entries for the selected date range will be cleared and replaced with the imported log.

5. **Start Import button**
   - Click the **Start Import** button to start the importing process.

6. **Cancel button**
   - Click the **Cancel** button to close the window.
**Scheduled Events**

Scheduled Events can be used to trigger actions at a specific time (one-off or recurring). For example, you may wish to start playout at a specific time, change the playout mode to Auto when PlayIt Live starts or automatically insert adverts every hour.

To get started, go to **Manage > Scheduled Events** and click **Add New**:

Enter a **name** for the event and when you want it to trigger. You can choose for it to **trigger** at a specific time (**Once**), recurring (**Daily** or **Weekly**) or when PlayIt Live starts (**On startup**). When choosing Daily you can select additional hours for when you want the event to trigger - this also means you can set the event to trigger every hour. When choosing Weekly you can select additional days for when you want the event to trigger - this also means you can set the event to trigger at the same time every day.

Every event has a series of **actions** which are executed sequentially when the event is triggered. Click the [+] button to add an action.

There are a range of actions available, simply double-click on the action you wish to execute in the event. Some actions require additional parameters for which you will be prompted after you have selected the action.
Action parameters that are more complex and may require more explanation are Insert Track, Insert Special and Insert External Log/Playlist.

After configuring the action it will appear in the list. Simply add more actions as you need them. Use the Move Up and Move Down buttons to reorder the actions if required.
You can set events to **expire** after a specific time if they are no longer valid, or **disable** them completely.

Click **OK** to close the window and return to the Managed Scheduled Events window.

Remember to click **Apply** or **OK** on the Manage Scheduled Events window to apply your changes.
TIP: Use the Clone button on the Events list or Actions list to quickly duplicate the item.

When the specific time is reached, or PlayIt Live is started, the scheduled events will be triggered.

NOTE:
Events are triggered sequentially. If you have two events set to trigger at 23:15:00, all the actions in one event will be triggered, immediately followed by all the actions in the next.
Use the Insert Track action to insert a track into the log at a specific position. Select from a Track from the Track List, a Track Group from the Track Group List or a File from the file system.

You can choose to insert the track to play next (after the current track), at the end of the current hour, at the start of the next hour or the end of the next hour.

If you choose to select a track from a track group, you can choose to try to respect existing playout policies. When selected, PlayIt Live will try to insert a track from the track group that does not violate the playout policies. If it cannot find a track, it will simply insert one from the track group at random.

If you choose to select a file from the file system, you can choose whether to automatically analyse the file for silence at the start and the end of the track.
Use the Insert Special action to insert special playout log item types, such as Fixed Time Markers, Break Notes, Remote URLs or Aux Inputs.

You can choose to insert the track to play next (after the current track), at the end of the current hour, at the start of the next hour or the end of the next hour.
The Insert External Log/Playlist action can be used to insert a log from an external scheduler or a playlist from another media player. For **Specific file** simply select the file from your file system. This action will behave the same way as when importing a log via the Import Playout Log Window except the current log will not be replaced, log items in the selected file will be inserted in the selected position.

It is also possible to insert a log/playlist file based on the name of a file in a folder. For example, you can select an Adverts folder, and then name files based on the time when they should play. In the example above, the date pattern used allows for a file name to be chosen dynamically based on the time of day.

Dynamic date parts are enclosed in % signs. Other text is treated as normal text. Date parts that can be used are:

- \%yy\%: 2 digit year.
- \%yyyy\%: 4 digit year.
- \%M\%: Month of year (e.g. 6)
- \%MM\%: Month of year, zero-padded (e.g. 06)
- \%MMM\%: Abbreviated month name (e.g. Jun)
- \%MMMM\%: Full month name (e.g. June)
- \%d\%: Day or month (e.g. 3)
- \%dd\%: Day of month (zero-padded, e.g. 03)
- \%ddd\%: Abbreviated day name (e.g. Sat)
- \%dddd\%: Full day name (e.g. Saturday)
- \%H\%: Hour of day in 24-hour clock (e.g. 7)
- \%HH\%: Hour of day in 24-hour clock, zero-padded (e.g. 07)
- \%h\%: Hour of day in 12-hour clock (e.g. 7)
%hh%: Hour of day in 12-hour clock, zero-padded (e.g. 07)
%tt%: AM/PM designator, (e.g. PM)
Users

Users can be managed within PlayIt Live to allow different people to log in and restrict them to certain permissions. For example, an administrator can log in and have the ability to change all settings and manage all types of entities, such as tracks and clocks. Alternatively, a presenter can be restricted to just the main interface and cannot add new tracks and change audio devices in settings.
Users can be managed via **Manage > Users**

1. **Require users to log in**

   - **Tick this box to require users to log in to use PlayIt Live. Please ensure before you tick this box that you know correct usernames and passwords and how to log into the system.**

2. **Users list**

   - **This list shows all the users in the system, including their Display Name, Username and Last Logged In time. You can delete the user using the delete icon. Please note, you cannot delete the administrator user.**
Click **Add New** to add a new users.
Click **Edit** to edit the selected user. You can also double click the user in the list.
Click **OK** to save any changes and close the window.
Click **Cancel** to discard any changes.
Click **Apply** to save any changes without closing the window.
Display name

The real name of the user. This is displayed on the main interface to display who is currently logged in.

Username

The username used by the user to log in. This must be unique and cannot be used by any other user.

Password

The password used by the user to log in. The password must be at least 6 characters long. If editing a user, you can leave this blank to keep the existing password. Use the Generate button to quickly generate a new password that can be given to the user:

Tick the User must change password at next login box to require the user to change the password to something they can remember.

Note that passwords are cryptographically hashed and stored in the database. The actual password is not stored, therefore cannot be retrieved if forgotten. Please take care not to lock yourself out of the system.
This section allows you to select what features the user is allowed to do. Ticking **Is Admin?** will allow the user to use any feature and perform any action. Where the user does not have permission to perform a particular action that section will be disabled or hidden on the user interface.

**Disabled**

Tick this box to disable the user, preventing them from logging in.

**OK/Cancel**

Click **OK** to save the changes. Click **Cancel** to discard the changes.
Use this tool to scan for tracks that reference file paths that no longer exist on your file system. If any are found you can choose to update the file path or delete the track entirely.

To get started, click the **Scan for missing track files** button.

Any tracks that are found that have the audio file missing will be displayed. Click in a **Resolution** cell of a row to choose what to do with the track:

- Do Nothing
- Update the path
- Delete track

You can **Do Nothing**, **Update the path** to a file you can find on the file system, or **Delete** the track. When choosing **Update path** you can choose a new path by selecting a path from the **New Path** column. After selecting a new path, PlayIt Live will check all the other tracks to see if they have also been moved to that location. If so, it will also update these to **Update path** if they have not already been resolved.

You can bulk resolve rows by multiple selecting using the CTRL or SHIFT keys and clicking the **Mark selected** button and choosing the resolution.
Once you have selected your resolutions, click the **Resolve** button.

PlayIt Live will update or delete the tracks based on your resolutions.
Use the Duplicate Track File Analysis window to find tracks whose file path already exist in PlayIt Live database. If any are found you can remove the duplicate track from the database.

To get started, click the **Scan for duplicate track files** button.

Any duplicate tracks that are found will be displayed. Click the **Remove Duplicates** button to remove the duplicate tracks.
Monitored Folders Status

This list shows all monitored folders and their current status. It shows the number of files found in the folder, how long the last scan took, and what was found during the last scan.

A countdown is shown until the next scan.

Note: It is possible that the folder monitored can repeatedly report new files. This can happen if there are files that are not considered valid tracks. They will be considered 'new' for each scan as they do not exist in the database.

Re-scan now

This button can be used to force monitored folders to be scanned immediately and bypass the wait time.
It is possible to remotely manage data added to PlayIt Live by starting the built-in remote management server. Once started, remote management can be accessed via a web browser where data such as tracks and track groups can be edited.

To help you set up your computer so you can access the remote management server from the internet, you can click the **Help me set up external access** button and follow the instructions.
The web interface works the same as that of PlayIt Manager. Please follow the PlayIt Manager documentation for instructions of how to use the web interface.
Synchronising Data

PlayIt Live data can be remotely managed and synchronised to multiple PlayIt Live instances by using the dedicated remote management server, PlayIt Manager or the built-in remote management server in PlayIt Live. PlayIt Manager can be downloaded from https://www.playitsoftware.com/Products/Manager. Details on how to use PlayIt Manager can be found on that page.

PlayIt Live can connect to a remote management server via a URL (Uniform Resource Locator). This is the base web address of your remote management server instance. For example: http://<server name goes here>:25432. For more information on how to connect to your remote management server, see the Connect PlayIt Live page on the web interface.

When PlayIt Live connects to a remote management server, it switches to using a separate 'synced' database to the normal 'local' PlayIt Live database to store the remote data. When you first connect, you may notice all your tracks 'disappear'. This happens as you will now be using the empty 'synced' database instead of the 'local' one. While PlayIt Live is connected to a remote management server it synchronises changes and applies them to the database. This process will populate the data to match the ones seen on the remote management server. When changes are made via the remote management server the same changes will immediately be applied to PlayIt Live.

When you disconnect PlayIt Live from the remote management server, it will switch back to using the normal 'local' database, and your previous local data will be displayed.

If for whatever reason you notice that data is out of sync, disconnect from the remote management server and connect again, except hold SHIFT while clicking the Connect button to clear you synced data and resync from scratch.

While connected to a remote management server it is not possible to manage PlayIt Live data directly from PlayIt Live. The only exception to this is the playout log - modifications made to the playout log via the main window will be synced to the remote management server.

Voice track synchronisation
Please note that voice track recordings are not current synced via the remote management server.

Track path substitutions
When PlayIt Live is connected to a remote management server it will be using tracks that were added to the remote management server. If the remote management server software is installed on a different machine to PlayIt Live, the track files added to that software will not be present on the PlayIt Live machine. In order to resolve this problem, track path substitutions which can be configured from the Settings page on the remote management server. These are designed to substitute parts of the file path on the server with a file path that can be accessed by the PlayIt Live machine.

For example, the audio store on PlayIt Manager is C:\ProgramData\PlayIt Manager\AudioStore. A network share can be created by going to the folder properties and creating a share via Advanced Sharing...
This will enable other machines on the network to access the audio files on the PlayIt Manager machine. On PlayIt Manager you should then add a track path substitution of:

**From:** C:\ProgramData\PlayIt Manager\AudioStore
**To:** \SERVER\AudioStore$

When track data is synchronised to PlayIt Live, the track path substitutions will be applied when loading tracks for playout.
Connect to Remote Management Server Window

1. **Server URL**
   The URL (Uniform Resource Locator) to connect to. This is the base web address of the PlayIt Manager web application page. For more information, see the Connect PlayIt Live page on PlayIt Manager. Alternatively, use the **Browse...** link button to try and find any nearby PlayIt Manager servers.

2. **Connect button**
   Connect to the PlayIt Manager server with the provided URL.

3. **Disconnect button**
   Disconnect from the currently connected PlayIt Manager server.

4. **Server information**
   Displays helpful information indicate the state of the server connection. It will indicate when server changes are being processed by PlayIt Live.

5. **Close button**
Close button

Closes the window.
About PlayIt Live

1. **Current Version**
   - Version 2.03 (Build: 2210)

2. **New Version Check**
   - This version is up to date.
   - When a new version is available you will be notified with a link to download the latest version.

3. **OK button**
   - Click the **OK** button to close the window.